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K2’s Excel Best Practices And Features 

 

Microsoft Office Excel is one of the most widely used applications by accounting and financial 
professionals. Yet, many remain unaware of new and improved features in Excel and, therefore, 
fail to reach the level of productivity and accuracy they desire. Further, with new features 
appearing in Excel provided through Microsoft 365 subscriptions and the forthcoming release of 
Excel 2024, it is more important now than ever to get up-to-speed on the world’s most popular 
spreadsheet! 

Make plans now to elevate your Excel skills by participating in this session. In it, you will learn 
about many of the newer features available to improve efficiency and accuracy. You will also 
learn about the importance of some of Excel’s legacy features and how you can – and should – 
continue to use these tools to improve productivity. 
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Introduction 
Microsoft Office Excel is one of the most widely used applications by accounting and financial 
professionals. Yet, many remain unaware of new and improved features in Excel and, therefore, 
fail to reach the level of productivity and accuracy they desire. Further, with new features 
appearing in Excel provided through Microsoft 365 subscriptions and the forthcoming release of 
Excel 2024, it is more important now than ever to get up-to-speed on the world’s most popular 
spreadsheet! 

Make plans now to elevate your Excel skills by participating in this session. In it, you will learn 
about many of the newer features available to improve efficiency and accuracy. You will also 
learn about the importance of some of Excel’s legacy features and how you can – and should – 
continue to use these tools to improve productivity. 

Learning Objectives 
Upon completing this session, you should be able to: 

• List examples of new functions and features in Excel 
• Differentiate between Excel 2024 and subscription-based versions of Excel 
• Identify steps necessary to automate tasks in Excel 
• Specify the actions required to integrate data from other sources into Excel 

New And Forthcoming Features 
Like most applications, Excel continues to evolve, and Microsoft continuously adds new and 
updated features. These new features appear in Microsoft 365-based subscriptions monthly or 
semi-annually, depending on the update cadence you or your IT staff select for your subscription. 
In addition, new features will undoubtedly appear in the upcoming Excel 2024 release. As of the 
publication date of this material, Microsoft has not published a complete list of the new features 
it will add to Excel 2024. However, we can reasonably infer that features previously added to 
Microsoft 365 will appear in Excel 2024. Based on that assumption, the list provided in the 
appendix contains new features Microsoft will likely include in Excel 2024. Further, we 
demonstrate five of these features below. 

Excel’s LAMBDA Function 
LAMBDA is a tool for creating custom functions in Excel. Once you create a custom function using 
LAMBDA, you can use it in any new Excel workbook if you save it in your default Excel template 
file, book.xltx. 

Consider the following example. Each month, you must allocate corporate overhead expenses to 
the Finance, Manufacturing, and Executive departments. Further, the allocation percentages are 
19%, 48%, and 33%, respectively. You create a formula like the one shown in Figure 1 to perform 
the allocation.  
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Figure 1 - Formula Used To Allocate Overhead Expenses 

Of course, you must re-create this formula monthly because you use a different workbook each 
month to complete your close-out tasks.  

Alternatively, you can use LAMBDA to store your formulas for future use, eliminating the need 
to re-create them repeatedly. Perform the following general steps to create a LAMBDA. 

1. Create and test the formula you want to save as a LAMBDA so you know it performs as 
intended and provides accurate calculations. 

2. When you’re ready to save the formula as a LAMBDA, click Name Manager on the 
Formula tab of the Ribbon and then click New. This action initiates the process of creating 
a new defined name that the formula you will save as your LAMBDA. 

3. Enter the required fields in the New Name dialog box and click OK to save your new 
LAMBDA. 

4. Once you create and save your formula as a LAMBDA, you can use it just like any other 
Excel function. 

A Specific Example 
Returning to the example above, suppose you wanted to automate overhead allocations. You 
can do this by creating LAMBDAs and using them to distribute the expenditures. Specifically, 
assume you want a formula to charge 19% of overhead to the Finance team, 48% to the 
Manufacturing organization, and 33% to the Executive group. 

To create a LAMBDA to allocate 19% of overhead to the Finance team, click Name Manager on 
the Ribbon’s Formulas tab. Next, enter the following data in the formulas dialog box, enter the 
following data. 

• Name: Enter the name you are assigning to your LAMBDA. You will use this name to call 
the function in your Excel workbook. 

• Scope: Identify whether you can use the LAMBDA throughout the workbook in which you 
save it or whether you want to restrict its use to a specific worksheet within the 
workbook. In general, you will likely want to establish workbook-level scopes. 

• Comment: If desired, add an optional comment describing your LAMBDA. 
• Refers to: Enter the parameters for your LAMBDA and the formula used to calculate the 

result. A parameter is information you need to pass to your LAMBDA. Often, a parameter 
is a cell reference, but it could also be a string or a number. 

To illustrate, consider the LAMBDA pictured in Figure 2. That user-defined function allocates 19% 
of the overhead to the Finance group. Specifically, in the Refers to box, the LAMBDA passes the 
Overhead parameter and a formula that multiplies that parameter by 19%. 

=IF(B5="Finance",0.19*C2,IF(B5="Manufacturing",0.48*C2,IF(B5="Executive",0.33*C2))) 
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Figure 2 - Creating An Excel LAMBDA To Allocate Overhead 

After creating a LAMBDA, you can view it by accessing Excel’s Name Manager. To illustrate, 
consider the three LAMBDA visible in the Name Manager shown in Figure 3. Further, you can edit 
or delete a LAMBDA from the Name Manager. 

 
Figure 3 - Excel’s Name Manager 

Controlling Data Conversions 
Many Excel users struggle with how the application converts data from one format to another. 
As a result, these users often spend time manually correcting the formats added to their data. 
Microsoft addresses this issue in Excel with the newly added set of data conversion options. As 
shown in Figure 4, these options allow users to control many types of data conversions. For 
instance, if you enter, paste, or import “Sep15” into Excel, the Convert continuous letters and 
numbers to a date option will automatically change the entry to a date. 
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Figure 4 - Excel’s New Data Conversion Options 

PivotTable Overlap Improvements 
Many Excel users consider PivotTables to be the application’s best feature. PivotTables provide 
tremendous capabilities for users to summarize data – potentially vast volumes of data – without 
entering formulas. However, formatting options available to PivotTables have often lagged 
behind this tool’s calculating and summarizing capabilities. When two or more PivotTables reside 
on the same worksheet, conflicts between the PivotTables can arise when one attempts to 
overlap another. You will see a message indicating PivotTable Report Cannot Overlap when this 
happens. To solve the problem, right-click anywhere in the PivotTable and choose Refresh. Then, 
you can use the Move PivotTable option on the Ribbon’s PivotTable Analyze, Actions tab. 

TEXTBEFORE, TEXTAFTER, and TEXTSPLIT Functions 
Historically, when users needed to extract certain characters from text entries in Excel – for 
example, placing first names in one column and addresses in another – the methods for 
completing these tasks were sometimes challenging. For instance, although powerful, the 
formulaic approaches that use combinations of LEFT, MID, RIGHT, FIND, and other powerful 
functions are too demanding for many to complete. Further, the Text-To-Columns Wizard lacks 
flexibility. Additionally, Flash Fill requires users to run the routine repeatedly whenever the 
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underlying data changes. What is often needed is a formulaic approach that is simple and easy 
to implement. Excel users received such an approach when Microsoft introduced TEXTBEFORE, 
TEXTAFTER, and TEXTSPLIT; each of these functions does what their name implies – TEXTBEFORE 
extracts all data before a specific character, TEXTAFTER extracts all data after a particular 
character, and TEXTSPLIT splits text at the specified character. The following are introductory 
examples of each function. 

• =TEXTBEFORE(B3,"jumps") 
o This formula extracts all the text in cell C3 before the word “jumps.” 

• =TEXTAFTER(B6,"jumps") 
o This formula extracts all the text in cell C3 after the word “jumps.”  

• =TEXTSPLIT(B9,"jumps") 
o This formula generates a dynamic array for its response by splitting the text into 

two cells. One cell contains all the text in cell C3 that appears before the word 
“jumps.” The second cell of the formula results appears immediately to the right 
of the first cell and contains the remainder of the original string.  

Desktop Action Recorder 
Excel’s Desktop Action Recorder is a relatively new feature that allows you to interact with Excel 
and record your keystrokes and mouse clicks for playback as a script. Like a macro, a script is a 
segment of executable code you can execute in Excel. Newer versions of Excel allow users to 
create, edit, and run scripts using. Scripts can access the Excel object model and interact with 
worksheets, ranges, tables, charts, and other objects. Scripts can also use external libraries and 
APIs to enhance the functionality of Excel. 

Much like Excel’s Macro Recorder, the Desktop Action Recorder captures your keystrokes and 
mouse clicks and converts them to a variant of JavaScript. You can then run your scripts at any 
point to automate routine tasks, such as hiding and unhiding rows and columns, entering 
passages of texts, applying formats, creating tables, and running commands from the Ribbon. 
Scripts can access the Excel object model and interact with worksheets, ranges, tables, charts, 
and other objects. Scripts can also use external libraries and APIs to enhance the functionality of 
Excel.  

To use the Recorder, click Record Actions from the Ribbon’s Automate tab. You will notice the 
Record Actions pane on the right side of the Excel window. Click Record Actions in this pane to 
start the Recorder. The Record Actions pane shows the status of your script, including whether 
you are recording in relative or absolute mode, as shown in Figure 5. These modes work much 
like relative and absolute modes when generating a traditional macro in Excel. That is if you are 
in relative mode when recording, all the actions in the script will occur relative to your cursor’s 
location. On the other hand, if you are in absolute mode, the actions happen in the specific cells 
you designate, such as B3, A7, and G52.   Figure 5 below illustrates moving between relative and 
absolute references. 
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Figure 5 - Choosing Between Relative And Absolute References When Recording A Script 

Suppose you wanted to automate the process of creating a workbook. Specifically, you want to 
write a script to create a new workbook with all the following characteristics. 

• Your company’s name in cell A1,  
• The workbook’s creation date in cell A2, 
• Department names added as column headers – Sales, Production, Executive, and Admin 

as column headers, with cell borders below each label, and 
• Chart of Accounts added as row labels. 

To create the script, click Record Actions from the Ribbon’s Automate tab. Next, set the recording 
mode to absolute. Then, proceed with the keystrokes and mouse clicks necessary to add each 
desired element to the worksheet. Upon completion, your new worksheet may resemble that 
pictured in Figure 6. 
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Figure 6 - Worksheet Created While Creating A Script 

Once you have added all desired elements to the worksheet, turn off the Recorder.  

At this point, the task pane on the right side of the window has changed into the Code Editor 
pane, as shown in Figure 7. 

 
Figure 7 - The Code Editor Pane 
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Note that in the Code editor, you can choose from several actions: 

• Run the script 
• Edit the script 
• Add a description for the script 
• Add or remove a button to the workbook for running the script 
• Save a copy of the script to SharePoint or OneDrive 
• Monitoring all script activity 

Scripts provide a modern, powerful alternative to macros. Of note, scripts can run in web-based 
versions of Excel, whereas macros cannot. Thus, if you use web-based versions of Excel 
extensively – such as running Excel from within Teams – scripts are your only option for 
automating tasks. Therefore, you may consider investing a little time to familiarize yourself with 
scripts.   

Revisiting Power Query In Excel 
Unlike scripts, which are relatively new to Excel, Power Query has been available in Excel for over 
a decade. Yet, most Excel users remain unaware of the strength of Power Query and how it can 
elevate accuracy and efficiency. Power Query allows users to link data from almost any data 
source into Excel. Once you link the data, you can use it just as you would data that you manually 
keyed into the application. Thus, you can create your reports, schedules, and analyses once and 
refresh the data on demand. Further, from a practical perspective, Power Query has no limits on 
the volume of data you can link into Excel.1 

Power Query facilitates linking data from almost any source. For example, you can link data from 
other Excel workbooks, most common databases, text files, PDF documents, websites, and 
pictures. Further, you can simultaneously link data from multiple sources, as shown in Figure 8. 

 
1 From a technical perspective, if you use Power Query to link data directly to an Excel worksheet, you are limited to 
1,048,576 rows of data. However, if you use Power Query to link data into Excel’s data model, you are limited only 
by the resources available on your computer. 
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Figure 8 - Linking Data From Multiple Data Sources Simultaneously Using Power Query 
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Figure 9 - Editing An Existing Query In Power Query 

Transforming Data With Power Query 
Notwithstanding the boundless capabilities associated with using Power Query to link data, 
perhaps the most valuable feature related to the tool is its ability to transform data to be more 
useful and meaningful. Indeed, it is far beyond the scope of this course to cover every possible 
type of transformation you can create with Power Query. However, we would be remiss if we did 
not provide several examples of transformations you may find helpful when manipulating your 
data. 
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Pivoting Data with Power Query 
Often, the need to pivot data arises – for example, you have data in a tabular format and want 
to create a chart from that data. For this example, we will use the Expenses table shown in Figure 
10 as the basis for a chart.  

 
Figure 10 - Data For Power Query Pivot 

The steps to transform the data by pivoting it and returning it to Excel are as follows: 

1. Select any cell in the table and click From Table/Range on the Ribbon’s Data tab to open 
the Power Query Editor. 
 

2. With the Month column selected, click Date in the Data Type dropdown list on the 
Ribbon’s Home. Then, select Replace current in the dialog box, as shown in Figure 11. 
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Figure 11 - Change Column Type 

3. Select the Account column, which will provide the values to use across the chart’s 
columns when the query completes. Then, on the Ribbon’s Transform tab, click Pivot 
Column. 
 

4. In the Pivot Column dialog box in Figure 12, select Amount as the Values Column and 
click OK. 

 
Figure 12 - Values Column 

5. With the data pivot completed in Power Query, select Close & Load on the Home tab to 
return the data into Excel. 

 
Figure 13 - Pivot Data Close & Load 

Using the data in the Excel table, we can quickly create a chart similar to the one pictured in 
Figure 14. Notably, refreshing the query updates the chart automatically when users add new 
data to the Expense table. 
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Figure 14 - Expense Chart Resulting From Transformed Using Power Query 

Unpivoting Data 
Exported reports often provide data in a format that requires us to unpivot it before using the 
information in our analyses. Using Power Query to unpivot the data will allow us to complete the 
steps quickly. Further, as new data appears, we can refresh the query to get updated, unpivoted 
results.  

For this example, we will use data exported from Sage 50 US; specifically, we will use the 
Customer Sales by Month report, previously exported to Excel. The report provides monthly 
results in a single row for each customer. Instead, we need to have the single row – which 
provides a date dimension – separated into unique rows for each data point. 

The steps to complete the unpivot are as follows. 

1. Click any cell in the data and then click From Table/Range on the Ribbon’s Data tab. 
 

2. The Create Table dialog box opens. If the data is not already a table, click OK. 
 

3. The Power Query Editor opens. Click the Total column’s heading to select that column. 
Then click Remove Columns on the Home tab to delete the unnecessary column. 

 
4. Double-click the heading for Column1 and change the name to Customer. 

 
5. On the Home tab, click the dropdown arrow in Remove Rows and select Remove 

Bottom Rows. For the number of rows, enter “1” and click OK to remove the total 
row. 
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6. With the Customer column highlighted, go to the Transform tab and click the 
dropdown arrow for Unpivot Columns; then click Unpivot Other Columns. Figure 15 
illustrates the results of these first steps. 

 
Figure 15 – Unpivoting Data In Power Query 

7. Figure 15 illustrates small icons at the front of each header. These icons indicate the 
type of data present in each column. The header indicates that the data is textual for 
the date column, as shown by the icon . Therefore, we must change it to the “date” 
data type by selecting the column and clicking the dropdown arrow for Data Type on 
the Home tab. Next, choose the Date option so that the icon in the header indicates 
the presence of date data . 
 

8. The final step is to click Close & Load on the Ribbon’s Home tab to load the 
transformed data into Excel.   

The list of Applied Steps in the Query Settings panel shown in Figure 15 provides an easy way to 
delete, reorder, and edit a step.  
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Any changes to the data appear in the results upon refreshing the query. To update the query 
results, click Refresh All on the Ribbon’s Data tab. Alternatively, you can click the Refresh icon in 
the Queries & Connections panel, as shown in Figure 16. 

 

Figure 16 – Power Query’s Refresh Icon 

Splitting Data into Multiple Columns with Power Query 
There are multiple ways to break data in a cell, including Flash Fill, Text to Columns, and functions 
such as LEFT, MID, RIGHT, and LEN. However, with both Flash Fill and Text to Columns, you must 
re-run these utilities each time your data changes – a process that may be impractical in some 
situations. In addition, although formula-based approaches update dynamically, formulas 
created using LEFT, MID, RIGHT, LEN, and other functions are challenging for many Excel users to 
construct. Fortunately, Power Query provides an easy and practical way to split data into multiple 
columns.  

With our data in the table shown in Figure 17, we will use Power Query to split the City, State, 
and Zip Code into separate columns. 
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Figure 17 – Data For Split Data Example 

The steps to complete the process are as follows. 

1. Select any cell in the table/range of data, and click From Table/Range on the Ribbon’s 
Data tab to open the Power Query Editor. 
 

2. Click Split Column on the Ribbon’s Home tab and select By Delimiter. For the first 
instance, use Comma and choose Each occurrence of the delimiter, as shown in Figure 
18. Then, click OK to confirm your entry. 

 
Figure 18 - Split Column By Delimiter 
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3. Repeat the Split Column process outlined above on the new column created and select 
space to split the State and Zip. 
 

4. Select the blank column and click Remove Columns on the Ribbon’s Home tab.  
 

5. Double-click each header and rename them to City, State, and Zip, respectively. 
 

6. Select the Zip column and select Text using the Data Type dropdown on the Ribbon’s 
Home tab. 

 
7. Click Close & Load to return the data as a table to Excel. 

To include any new data added to the source table, right-click on the table created by the query 
and click Refresh.  

Transforming Data by Adding Columns 
Power Query provides a simple interface for adding a column of data. In this illustration, we will 
use Power Query’s Column From Examples feature to add a column of data to the data model. 
To add a column, follow the steps detailed below. 

1. Click on any cell in range or table, and click From Table/Range on the Ribbon’s Data tab 
to open the Power Query Editor. 
 

2. Click Column From Examples on the Add Column tab of the Power Query Editor’s 
Ribbon. 
 

3. We will combine the Department and Account number for the first new column by typing 
the department name and account number on the first line in the new column and 
pressing Enter. This process resembles using Flash Fill in Excel; however, it completes an 
editable function shown in Figure 19. Review the results and click OK. 
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Figure 19 - Add Column From Examples 

4. We will now add a second column using the same process to combine the FiscalPeriod 
(month) with the FiscalYear. Because no day of the week is specified, we will input the 
first day of the month, as shown in Figure 20. Click OK to complete the process, and then 

click the text icon  in the header for the column to change the type to date. Next, 
rename the column to Date. 

 
Figure 20 - Adding A Second Column 

5. To allow for reporting on a month-end basis, add another column using Custom Column 
on the Ribbon’s Add Column tab. To do so, complete the dialog box, as shown in Figure 
21, and click OK. 
 

6. Change the column type to date. 
 

7. Click Close & Load to complete the process on the Ribbon’s Home tab. 
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Figure 21 - Custom Column Created In Power Query 

As with queries, the steps created automatically re-run when you refresh the query.  

Creating a Transformation to Transpose Data 
Excel provides the Paste Special, Transpose feature, and the Transpose function. Both these 
tools are helpful for transposing data by “rotating” it 90 degrees. However, Paste Special, 
Transpose is a one-time action, and the Transpose feature does not work if the range changes. 
These two issues severely limit the usefulness of these two tools. Fortunately, Power Query 
eliminates both limitations with its Transpose option. 

The data is not in a table in this first example of using Transpose in Power Query. Choose From 
Table/Range on the Ribbon’s Data tab to begin the process of transposing data. Next, you should 
uncheck the box labeled My Table has Headers, as shown in Figure 22.  
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Figure 22 - Uncheck My Table Has headers 

Complete the transpose process using the following steps with the data now in the Power Query 
Editor. 

1. On the Transform tab of the Ribbon, click Transpose. 
 

2. On the same tab, click Use First Row as Headers. 
 

3. On the Home tab, select Remove Rows, Remove Bottom Rows, and choose to remove 
only one row. Click OK. 
 

4. To complete the transpose, click Close & Load, and upon doing so, Power Query 
transposes the data. If the original data changes, right-click anywhere on the “results” 
data and choose the Refresh option to update the results. 

Combining Excel Worksheets with a Power Query Transformation 
We will combine expense data from one worksheet with budget data from another worksheet 
using Power Query in the following example. For both sets of data, use From Table/Range to 
create a connection to the data. Create the connection for the Sales data. Then, in the Query 
Settings panel of the Power Query Editor, change the query’s Name to Actuals.  

Next, repeat the previous process for the Budget data and name it Budget. Then, click the Close 
& Load dropdown arrow with each query and select Close & Load To. This action opens the 
Import Data dialog box. There, select Only Create Connection, as shown in Figure 23. Finally, 
complete these processes by clicking OK.  
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Figure 23 – Using Power Query To Create A Data Connection 

With the two queries completed, you can combine the two worksheets using the following steps. 

1. In the Get Data dropdown list, select Combine Queries followed by Append. 
 

2. Configure the Append dialog box, as shown in Figure 24, and click OK. 
 

3. Next, select the Month and Product columns and click Group By on the Home tab. 
 

4. Configure the Group By to sum the Sales and Budget columns, as shown in Figure 25, 
and click OK. 
 

 
Figure 24 – Appending Query Results 
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Figure 25 – Grouping Data From Query Results 

5. In the Query Settings panel, change the query’s name to Actual vs. Budget, review 
the data types, and make any changes required. 

 
6. Click Close & Load to return the results of combining the worksheets to Excel.  

Far from an exhaustive list of all the queries and transformations possible using Power Query, 
the examples presented above clearly illustrate many of the tools’ features and benefits and 
should likely cause many to re-engineer some of their Excel workflows. 

Calculations With PivotTables 
In the opinion of many, PivotTables are Excel’s most important and most powerful feature. As 
mentioned earlier, PivotTables offer extraordinary opportunities to summarize large volumes of 
data without entering formulas. However, that characteristic has led to the widespread 
perception that PivotTable can only sum data and that other calculations, such as averages and 
variances, are unavailable in PivotTables. Different calculations are available, but to use them, 
you must think a bit differently about PivotTables.   

Perhaps the easiest way to see a different calculation in a PivotTable is to change the data’s 
presentation. For instance, Figure 26 illustrates changing a Value Field Setting to change the 
presentation of PivotTable data. Notably, this method does not involve changing any calculation 
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or adding any formula to the PivotTable. Further, you can add the same field to a PivotTable 
multiple times and choose a different presentation for each calculation instance. You can extend 
this technique to presenting the data as percentages of a column total or grand total by clicking 
on the Show Values As option in Figure 26. 

 
Figure 26 - Changing The Summary Function For A Value Field 

Creating Calculated Fields 
A calculated field is one form of a user-defined calculation you can add to a PivotTable. The other 
option for creating a user-defined measure is a calculated item. You will employ a calculated field 
to use data from different fields in your user-defined calculation. On the other hand, you will use 
a calculated item when you want your formula to use data from one or more specific items within 
a given field.  

This example creates a simple PivotTable from a single table in Sage 100, the customer master 
file, AR_Customers. We will use Open Database Connectivity (ODBC) – an open standard for 
connecting applications to a database – to access the database. With the connection in place, 
Excel presents a list of tables. You can expand this list to display the fields contained in each table. 
First, expand the field list by clicking the plus (+) sign to the left of the table name in the left-hand 
pane. Then, choose the fields to display in the report and click the (>) button. This action will 
move them to the right-hand pane, as shown in Figure 27. Next, select the following fields: 
CustomerNo, State, SalespersonNo, CurrentBalance, AgingCategory1, AgingCategory2, 
AgingCategory3, and Aging Category4. 
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Figure 27 – Selecting The Fields For The Report 

After selecting the required fields are selected, click Next several times. Select Return Data to 
Microsoft Office Excel and click Finish. In the Import Data dialog box, select the PivotTable 
Report. Then,  specify the location for the report and then click OK. Next, drag-and-drop the fields 
to the appropriate report quadrants in the PivotTable Task Pane, rename and format the column 
labels, choose a number format for the data, and complete the PivotTable just as with any other. 
The primary difference is that this PivotTable links dynamically to the underlying data in the 
database. If you need the same report next week or next month, you must retrieve the workbook, 
refresh the PivotTable, and print the updated version, which takes mere seconds to complete. 
Figure 28 illustrates creating the initial PivotTable. 



Page 26 of 38 
 

Copyright © 2024, K2 Enterprises, LLC.  
Reproduction or reuse for purposes other than a K2 Enterprises training event is prohibited. 

 

 
Figure 28 – Creating A PivotTable Connected To An External Data Source 

Our initial PivotTable contains an accounts receivable aging report but does not have a column 
for the total outstanding balances owed by our customers. To create a column for the 
outstanding balances, we need to create a calculated field because we must include the values 
from other fields in the formula. 

To insert a calculated field, follow the procedure described below. 

1. Position the cursor anywhere in the Over 120 column. 

2. Click Fields, Items, & Sets followed by Calculated Field on the PivotTable Tools, Analyze 
contextual tab.  

3. Type a name for the added field in the Insert Calculated Field dialog box. In this case, 
enter Balance. 

4. Then, build the formula. Position the cursor in the Formula box, click and highlight 
CurrentBalance in the Fields box, and click Insert Field. Next, type in the plus sign (+) and 
click and highlight AgingCategory1 in the Fields box. Again, click on Insert Field. Repeat 
this process until you include all fields through AgingCategory4 in the Formula box. Click 
OK to complete the process, as shown in Figure 29. 
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Figure 29 – Entering A Formula For A Calculated Field 

5. Excel adds the new field in a separate column to the right of the Over 120 column. 

To complete the table, drag SalespersonNo to the Rows quadrant and the CustomerName field 
to the Filters quadrant. The reconfigured PivotTable helps users examine and understand their 
staff’s sales and collection performance. Similarly, we could have replaced SalespersonNo in the 
Rows quadrant with State to produce an accounts receivable aging of accounts by state, which 
could help users manage the risk of non-collection in specific locations. Figure 30 displays the 
completed PivotTable.  

 
Figure 30 – Aging of Accounts Receivable By Salesperson 

Remember, our PivotTable links dynamically to the underlying data in Sage 100. So, to use this 
report in the future, retrieve the workbook and click Refresh to produce an updated summary 
based on the transactions and postings as they exist in the underlying database at the time of 
refresh. 
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Creating Calculated Items 
Now, let us turn our attention to the task of creating a calculated item. Remember, we will use 
calculated items to incorporate the values associated with other items into our formulas. In our 
first example, we will create a calculated item to compute the gross margin from the PivotTable 
pictured data in Figure 31. 

 
Figure 31 – Simple Consolidation PivotTable 

To insert a calculated item, use the following procedure. 

1. Select any one of the row items, such as Revenue, Cost of Sales, or Distribution. 

2. In Excel, on the Ribbon’s PivotTable Tools, Analyze tab, click Fields, Items, & Sets 
followed by Calculated Item, as shown in Figure 32. 
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Figure 32 - Creating Formulas From The PivotTable Analyze Tab Of The Ribbon 

3. In the Insert Calculated Item dialog box, enter a name for the added item. Enter Gross 
Margin. 

4. Now, build the formula. First, position your cursor in the Formula box, click and highlight 
Revenue in the Items box in the lower right-hand corner, and click Insert Item. Next, type 
in the minus sign (-) and click and highlight Cost of Sales in the Items box. Finally, click 
Insert Item and OK to complete the process, as shown in Figure 33. 
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Figure 33 – Entering the Formula For A Calculated Item 

5. Excel will create an item at the bottom of the column. Use your mouse to drag the item 
to the correct position in the report.  

 
Excel will display an error message if you now attempt to group months 
into quarters in the PivotTable report because the built-in date and 
number grouping are not allowed across calculated items in PivotTables.  

Summary 
Excel is a fantastic tool that continues to evolve. New features such as LAMBDA, data conversion 
options, a powerful scripting language, and functions such as TEXTBEFORE, TEXTAFTER, and 
TEXTSPLIT are welcome additions to an already powerful application. But, leveraging legacy tools 
in Excel such as Power Query and various PivotTable techniques can also contribute significantly 
to improved accuracy and efficiency. Take advantage of the tools and features discussed in this 
session to maximize your return on investment with Excel. 
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Appendix – Summary of New and Updated Excel Features 
Adapted from Microsoft’s Website 

Date 
Released 

Current 
Channel 
Version 
Number 

Func�on Name Func�on Descrip�on 

1/4/2024 2312 Sensi�vity Toolbar The sensi�vity bar is now available in Word, Excel, and PowerPoint when 
users are crea�ng copies of their documents in File / Save As. This helps 
users understand the security policies that apply to their document. 

1/4/2024 2312 New Default Theme We’ve updated the default font and colors of the Office theme to be more 
modern and accessible. 

11/29/2023 2311 Automa�cally insert image 
cap�oning for Excel’s images 

Excel’s spreadsheet and accessibility image cap�oning is automa�cally 
generated for you. 

10/25/2023 2310 Efficient reading in Excel using 
Narrator 

Announcements through the Windows inbox screen reader, Narrator, will 
be much more succinct and efficient. 

10/28/2023 2309 Control your data conversions You’ve been asking for more control over how Excel automa�cally converts 
your data to specific formats. We delivered! You now have the ability to 
disable specific types of automa�c data conversions; this way, you won’t 
need to worry about Excel conver�ng your data to a format that you didn’t 
want and weren’t expec�ng. 

8/28/2023 2308 Data Valida�on dropdown list 
autocomplete 

Dropdown lists are a handy way to make data entry and valida�on more 
efficient in Excel. We’ve now added AutoComplete func�onality, which 
automa�cally compares the text typed in a cell to all items in the 
dropdown list and displays only the items that match. You’ll spend less 
�me scrolling through lists, dealing with data valida�on errors, or wri�ng 
complex code to handle this task. 

8/28/2023 2308 Paste values directly into your 
workbook using a keyboard 
shortcut 

The keyboard shortcut CTRL+SHIFT+V lets you quickly Paste Values rather 
than having to choose Paste Values from the menu. 

8/28/2023 2308 Updated encryp�on for 
Microso� Purview 
Informa�on Protec�on 

Advanced Encryp�on Standard (AES) with 256-bit key length in Cipher 
Block Chaining mode (AES256-CBC) is now the default Microso� Purview 
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Informa�on Protec�on encryp�on mechanism for Microso� 365 Apps 
documents and emails. 

8/28/2023 2308 Protect your most sensi�ve 
content with double key 
encryp�on 

Double Key Encryp�on (DKE) provides organiza�ons with a second 
encryp�on key for your most sensi�ve content. 

7/26/2023 2307 PivotTable overlap 
improvements 

We have improved the experience when PivotTables overlap other content 
in your workbook. 

7/26/2023 2307 Performance improvement 
related to fonts 

If you do not use printer fonts or have not heard of printer fonts, 
unchecking the se�ng in File/Op�ons/Advanced/[Include fonts that are 
stored on the printer] can help speed up font related opera�ons such as 
choosing a font from font drop down, or forma�ng a cell by 
bolding/italicizing a cell’s font, etc. 

6/1/2023 2305 Faster filtering when cells 
contain unique or duplicate 
rules 

When your workbook contains many unique or duplicate condi�onal 
forma�ng rules, it can o�en slow down the app’s performance. No 
longer! By op�mizing the underlying comparison algorithm, we’ve 
enhanced the performance and sped up the filtering process. 

6/1/2023 2305 Desktop Excel Ac�on Recorder You can now record Office Scripts in Desktop Excel! Perform the ac�ons 
you want in Excel, and the Recorder will create an Office Script to replay 
those ac�ons for you. 

3/28/2023 2303 Reducing unwanted 
fragmen�ng of condi�onal 
forma�ng rules 

Check out the speed up in workbooks with lots of unwanted fragmented 
condi�onal forma�ng rules. When a workbook is opened this feature will 
merge those fragmented condi�onal forma�ng rules that are iden�cal, 
within a con�guous range of cells, and with unchanged priority ordering. It 
excludes rules whose evalua�on relies on a selec�on range like Above or 
Below average, Unique or Duplicate, Gradients, etc. and rules in 
PivotTables. 

3/28/2023 2303 Assign a sublabel as the 
default when a parent label is 
selected 

When using built-in sensi�vity labels in Microso� 365 Apps, admins can 
specify a sublabel to get applied automa�cally when a parent label is 
selected. This takes effect only when users select a parent label manually. 

3/28/2023 2303 Sensi�vity Label scoping 
between files, emails and 
mee�ngs 

Office applica�ons can now filter out sensi�vity labels based on the 
document type. For example, Outlook email will no longer show labels 
that only apply to Word, Excel, and PowerPoint documents. 
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3/28/2023 2303 Blocking XLL add-ins from the 
internet 

To address the increasing number of malware atacks in recent months, we 
are implemen�ng measures that will block XLL add-ins coming from the 
Internet. 

3/28/2023 2303 Track tasks with @men�ons Use @men�ons in comments to create, assign and track tasks within your 
workbook 

3/28/2023 2303 Formula evalua�on tool�ps Select a part of your formula and you’ll see a tool�p showing the current 
value of just the part you’ve selected. 

3/14/2023 2302 Disable the Azure Informa�on 
Protec�on Add-in by default 

Office apps will now automa�cally disable the legacy Azure Informa�on 
Protec�on add-in and use the built-in sensi�vity labels to view and apply 
labels powered by Microso� Purview Informa�on Protec�on. 

3/14/2023 2302 Prevent data leaks more easily 
with the new Sensi�vity 
toolbar 

Sensi�vity labels powered by Microso� Purview Informa�on Protec�on 
are now displayed alongside the filename in the app’s �tle bar, allowing 
you to easily recognize and adhere to your organiza�on’s policies. The 
sensi�vity toolbar is also available while saving new documents or 
renaming exis�ng ones, helping you keep informa�on security at your 
finger�ps. 

2/28/2023 2302 Reducing slowness and 
freezes when mul�ple 
workbooks are open 

This feature reduces slowness and freezes experienced when working in a 
workbook due to calcula�ons occurring in other unrelated workbooks also 
open at the same �me and in the same Excel.exe instance. It achieves this 
by op�mizing global automa�c recalcula�on to the workbook being 
worked in, and its interdependent workbooks also open at the same �me. 

2/28/2023 2302 User-defined permissions now 
support domain name 
restric�ons 

When you choose a sensi�vity label configured for user-defined 
permissions, domain names can now be used to restrict file access to all 
individuals from that domain. For example, you can specify 
“someone@example.com” or “@example.com,” and permissions will be 
restricted based on either the individual or all individuals within the 
example domain. 

1/26/2023 2301 PivotTable overlap 
improvements 

We have improved the experience when PivotTables overlap other content 
in your workbook. 

1/26/2023 2301 Excel PivotTable version 
compa�bility user messaging 

Excel now gives alerts about PivotTable compa�bility issues and provides 
informa�ve documenta�on and workarounds. When your version of Excel 
is unable to read data in a workbook, we present users with 
documenta�on that provides op�ons to proac�vely troubleshoot and 
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resolve the issue. In addi�on, we also allow users to upload their Excel 
document to OneDrive so they can seamlessly open the file in Excel for the 
web. 

1/26/2023 2301 Date support for PivotTables 
Connected to PowerBI 

In PivotTables that are connected to Power BI datasets, dates are now 
supported for analysis as the data type is no longer a string. For example, 
filtering data on specific �meframes is now possible. 

12/6/2022 2211 Insert in-cell images with the 
new IMAGE func�on 

Your images can now be part of the worksheet, instead of floa�ng on top. 
You can move and resize cells, sort and filter, and work with images within 
an Excel table. 

12/6/2022 2211 Touch Improvements to 
Ribbon 

We’ve improved the spacing of butons in the Ribbon when the device is 
being used in Tablet posture. 

10/27/2022 2210 Get data for your workbooks 
by impor�ng an image 

Turn images with text into content you can edit in Excel. With the Data 
from Picture feature, you can convert the informa�on in an image to data 
on a worksheet. 

8/31/2022 2208 Supercharge your worksheets 
with fourteen new text and 
array func�ons 

Use fourteen powerful new func�ons to easily split your text and 
rearrange your data. Try using TEXTSPLIT to split your text or VSTACK to 
combine mul�ple arrays. 

8/31/2022 2208 Protect your PDFs Sensi�vity labels are now available to protect your PDFs from 
unauthorized access. Applies to files created in Word, Excel, or 
PowerPoint. 

8/3/2022 2207 Op�mized Excel recalcula�on 
on devices with constrained 
resources 

On resource-constrained devices (two cores or less and eight gigabytes of 
RAM or less), Excel has now by default made recalcula�on more op�mal 
by running calcula�on on a single thread. In most cases, users should see 
no�ceably faster calcula�on on these devices. Note that in some cases 
that require compute-intensive calcula�on, users may want to consider 
overriding this default by se�ng Number of calcula�on threads to “2.” 

6/29/2022 2206 Copy data from the status bar Quickly copy informa�on from aggrega�ons like “Sum,” “Average,” and 
“Count” from the status bar. 

6/29/2022 2206 Find your data faster The Auto-Filter func�on is now no�ceably faster! These improvements 
were achieved by reducing memory usage and op�mizing the calls made 
by the filter’s comparison algorithm. The op�miza�ons are especially 
no�ceable on low-end devices that have less memory or slower CPU-
memory throughput.  
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6/29/2022 2206 Speeding up Formula Entry Excel has sped up entering a formula in a cell no�ceably by reducing 
memory usage, making more efficient use of allocated memory, and 
op�mizing redrawing. These op�miza�ons are more no�ceable on devices 
with slower Memory or slower CPU-Memory throughout for larger cell 
ranges. 

4/26/2022 2204 Reducing unwanted 
fragmen�ng of condi�onal 
forma�ng rules 

We’re reducing fragmen�ng of condi�onal forma�ng rules across a 
con�guous cell range when pas�ng copied cells into that cell range. 

4/26/2022 2204 Power BI Dataset Request 
Access Improvements 

This update presents users with a way to request access to Power BI 
datasets when atemp�ng to refresh PivotTables in Excel that are 
connected to a dataset they don’t currently have access to. 

3/30/2022 2203 Want your workbook to take 
you places? 

Understand the layout of your workbook, see what elements exist, and 
navigate around quickly using the Naviga�on pane. 

2/28/2022 2202 Excel 4.0 (XLM) macros will be 
disabled by default to improve 
security for Microso� 365 
customers 

To help protect customers, Excel 4.0 (XLM) macros will be disabled by 
default in Microso� 365. We encourage you to migrate these macros to 
the latest version of Microso� Visual Basic for Applica�ons (VBA). 

2/28/2022 2202 Office apps now support Open 
Document Format (ODF) 1.3 

ODF 1.3 brought many improvements to the OpenDocument format and 
these are now supported in Word, Excel, and PowerPoint (file extensions 
.odt, .ods, and .odp). 

02/28/2022 2202 Lambda: Helper Func�ons 7 new func�ons, which make use of lambdas and provide help when 
authoring LAMBDA solu�ons 

02/28/2022 2202 Lambda: Custom Func�ons 
Without Code 

The LAMBDA func�on allows you to take any exis�ng formula or 
expression and turn it into a custom func�on with a name. Easily reuse 
and update logic in your spreadsheet with the LAMBDA func�on. 

10/25/2021 2110 DLP policy �ps in 
Word/Excel/PowerPoint 

Other sensi�ve informa�on types configured as part of OneDrive and 
SharePoint data loss preven�on (DLP) policies can now be detected by the 
app to show a policy �p. This update also brings accuracy improvements 
and globaliza�on support. 

9/28/2021 2109 A new way to reach the 
Accessibility tools 

The Accessibility ribbon puts all the tools you need to create accessible 
content in one place. 
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05/21/2021 2105 AutoSave and coauthoring on 
sensi�ve encrypted 
documents 

Don’t trade off produc�vity for security. With Microso� Purview 
Informa�on Protec�on, documents that are encrypted with sensi�vity 
labels can now be AutoSaved and co-authored with others in real �me just 
like unencrypted documents can. Requires tenant opt-in. 

4/29/2021 2104 Linked data types: Real data 
for real life 

New linked data types bring you facts and data on hundreds of subjects to 
help you accomplish your goals right in Excel. 

3/30/2021 2103 Government customers: Apply 
sensi�vity labels to your 
documents and emails 

Sensi�vity labeling features are now available for customers in the DoD 
environments. 

3/1/2021 2102 Unhide many sheets at the 
same �me 

No need to unhide one sheet at a �me anymore -- unhide mul�ple hidden 
sheets at once. 

3/1/2021 2102 Improved Condi�onal 
Forma�ng dialogs 

Condi�onal Forma�ng dialogs are now resizable, and now you can 
duplicate the rule with a single click. 

3/1/2021 2102 Require users to apply 
sensi�vity labels 

Users will be prompted to apply a sensi�vity label if their organiza�on’s 
policy requires it. 

1/26/2021 2101 Send audit data about 
sensi�vity labeling to M365 
administrators 

When users apply, change, or remove sensi�vity labels on their documents 
and emails, Office will send up audit data to the M365 audit backend for 
administrators to see. This is a silent func�onality (no UI) for administrator 
benefit. 

1/26/2021 2101 Government customers: Apply 
sensi�vity labels to your 
documents and emails 

Sensi�vity labeling features are now available for customers in the GCC 
and GCC-H environments. 

11/26/2020 2011 SVG Clipboard Support You can now paste SVG content from Office into 3rd party apps. 
11/26/2020 2011 Switch Office themes 

automa�cally 
Office can automa�cally switch themes to match your Windows 10 theme 
se�ngs. Go to File > Account and choose “Use system se�ng” under the 
Office Theme dropdown. 

11/26/2020 2011 Name the new sheet a�er the 
source query 

When the data is loaded into the new sheet, the sheet will be named 
based on the name of the source query. 

11/26/2020 2011 Use the Advanced Dialog to 
Create Data Types 

When the data is loaded into the new sheet, the sheet will be named 
based on the name of the source query. 

10/27/2020 2010 Create Data Types with Power 
Query 

Create rich data types with Power Query from any data source. 
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10/27/2020 2010 Insert your iPhone photos 
directly into Office 

HEIC pictures from your phone now insert seamlessly into Office. No 
conversion required. 

10/27/2020 2010 Make quick edits using the 
ac�on pen 

With the ac�on pen, you can write by hand directly in the cells, jot down 
data with ink that gets automa�cally converted to Excel data. 

9/28/2020 2009 Save shapes as pictures In just a few clicks, save a shape, icon, or other object as a picture file so 
you can reuse it elsewhere. 

9/28/2020 2009 Get Organiza�on Data from 
Power BI using Data Types 

Excel data types from Power BI are now rolling out to Insiders in 
organiza�ons with Office 365 / Microso� 365 and the Power BI Pro service 
plan. Ge�ng the informa�on you need and easily refreshing it’s cri�cal to 
many everyday workflows. We’re giving you access to your company or 
organiza�on informa�on from Power BI as a data type in Excel, which 
expands your ability to bring in linked informa�on in your spreadsheets. 

9/28/2020 2009 Create variables to use in 
formulas 

Improve performance, readability, and composability with the LET 
func�on. This func�on allows you to create named variables in new or pre-
exis�ng formulas. 

8/31/2020 2009 Save to Pinned Folders Pin your folders makes saving Office files easier. We received feedback that 
users want more control over the folders available when a new file is 
saved. We’re excited to bring a new capability to you: pin your folders in 
the Save dialog. This new capability will make saving your Word, Excel, and 
PowerPoint files easier. 

8/31/2020 2009 Make polished Visio diagrams 
in Excel 

Create a flow chart or organiza�onal chart by pu�ng data on a worksheet. 

7/30/2020 2007 Make a PDF connec�on Connect to, import, refresh data from a PDF. 
7/30/2020 2007 Filter and sort without 

disrup�ng others 
You can now sort and filter your Excel file while collabora�ng with others 
with Sheet View. This new feature prevents you from being impacted by 
other user’s sorts and filters while coauthoring the document. 

7/30/2020 2007 Auto-apply or recommend 
sensi�vity labels 

Office can recommend or automa�cally apply a sensi�vity label based on 
the sensi�ve content detected. 

7/30/2007 2007 Create PivotTables from 
Datasets in Power BI within 
Excel; 

You can create PivotTables in Excel that are connected to datasets stored 
in Power BI with a few clicks. Doing this allows you get the best of both 
PivotTables and Power BI. Calculate, summarize, and analyze your data 
with PivotTables from your secure Power BI datasets. 
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6/30/2020 2006 Longer file names Excel for Windows desktop now supports OneDrive/SharePoint files with 
names and paths of up to 400 characters. 

6/30/2020 2006 Real�medata (RTD) 
improvements 

In Office 365 version 2002 monthly channel and later, Excel’s RealTimeData 
(RTD) func�on is much faster than Excel 2010 calcula�ng data in the 
spreadsheet. We removed botlenecks in its underlying memory and data 
structures as well as made it thread-safe to allow it to be calculated on all 
available threads of Mul�threaded recalcula�on (MTR). 

6/92020 2005 Lasso eraser in Ink Toolbox When using the drawing tools, the lasso and the eraser are now available 
in the Ink Toolbox. 

6/2/2020 2005 Automa�cally use new data 
types 

When you type a data value that resembles a stock or a geographic 
loca�on, Excel offers to convert it to the right connected data type - Stocks 
or Geography. 

6/2/2020 2005 Tell your stories with 
animated GIFs 

Animated GIFs are now supported in the Office editor - your documents 
just got snazzier 

4/29/2020 2004 Facebook connector support 
is ending 

Star�ng in April 2020, Excel will no longer support external data 
connec�ons that use the Facebook connector. 

4/29/2020 2004 Have a ques�on? Ask Excel Now Excel Ideas allows you to ask ques�ons about your data - no need to 
spend �me wri�ng formulas 

4/29/2020 2004 New images to bring your 
workbooks to life 

Thousands of royalty-free stock images, icons, and s�ckers you can use in 
your workbooks. Go to Insert > Pictures > Stock Images to get started. 

3/25/2020 2003 Your favorite Excel func�ons 
just got faster. 

The SUMIFS, AVERAGEIFS, COUNTIFS, MAXIFS, and MINIFS func�ons are 
much faster than ever before. Get to the botom line more quickly. 

2/25/2020 2002 Workbook sta�s�cs Cells, formulas, charts, tables... We count them so you don’t have to. 
2/25/2020 2002 Data Profiling in Query Editor Get at-a-glance analysis of the data in your columns, iden�fy error and 

empty values, see distribu�on histograms and more. 
1/30/2020 2001 Read and reply on the fly Respond to comments and men�ons right from email without opening the 

workbook. 
1/30/2020 2001 XOOKUP is here! Row by row, find anything you need in a table or range with XLOOKUP 
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